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© Cypress Semiconductor Corporation, 2009-2011. The information contained herein is subject to change without notice.
Cypress Semiconductor Corporation assumes no responsibility for the use of any circuitry other than circuitry embodied in a
Cypress product. Nor does it convey or imply any license under patent or other rights. Cypress products are not warranted
nor intended to be used for medical, life support, life saving, critical control or safety applications, unless pursuant to an
express written agreement with Cypress. Furthermore, Cypress does not authorize its products for use as critical components
in life-support systems where a malfunction or failure may reasonably be expected to result in significant injury to the user.
The inclusion of Cypress products in life-support systems application implies that the manufacturer assumes all risk of such
use and in doing so indemnifies Cypress against all charges. 

Any Source Code (software and/or firmware) is owned by Cypress Semiconductor Corporation (Cypress) and is protected by
and subject to worldwide patent protection (United States and foreign), United States copyright laws and international treaty
provisions. Cypress hereby grants to licensee a personal, non-exclusive, non-transferable license to copy, use, modify, create
derivative works of, and compile the Cypress Source Code and derivative works for the sole purpose of creating custom soft-
ware and or firmware in support of licensee product to be used only in conjunction with a Cypress integrated circuit as speci-
fied in the applicable agreement. Any reproduction, modification, translation, compilation, or representation of this Source
Code except as specified above is prohibited without the express written permission of Cypress. 

Disclaimer: CYPRESS MAKES NO WARRANTY OF ANY KIND, EXPRESS OR IMPLIED, WITH REGARD TO THIS MATE-
RIAL, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. Cypress reserves the right to make changes without further notice to the materials described
herein. Cypress does not assume any liability arising out of the application or use of any product or circuit described herein.
Cypress does not authorize its products for use as critical components in life-support systems where a malfunction or failure
may reasonably be expected to result in significant injury to the user. The inclusion of Cypress’ product in a life-support sys-
tems application implies that the manufacturer assumes all risk of such use and in doing so indemnifies Cypress against all
charges. 

Use may be limited by and subject to the applicable Cypress software license agreement. 

PSoC® is a registered trademark of Cypress Semiconductor Corporation. All products and company names mentioned in this
document may be the trademarks of their respective holders.

Purchase of I2C components from Cypress or one of its sublicensed Associated Companies conveys a license under the
Philips I2C Patent Rights to use these components in an I2C system, provided that the system conforms to the I2C Standard
Specification as defined by Philips. As from October 1st, 2006 Philips Semiconductors has a new trade name - NXP Semicon-
ductors.

Flash Code Protection

Cypress products meet the specifications contained in their particular Cypress PSoC Data Sheets. Cypress believes that its
family of PSoC products is one of the most secure families of its kind on the market today, regardless of how they are used.
There may be methods, unknown to Cypress, that can breach the code protection features. Any of these methods, to our
knowledge, would be dishonest and possibly illegal. Neither Cypress nor any other semiconductor manufacturer can guaran-
tee the security of their code. Code protection does not mean that we are guaranteeing the product as "unbreakable."

Cypress is willing to work with the customer who is concerned about the integrity of their code. Code protection is constantly
evolving. We at Cypress are committed to continuously improving the code protection features of our products.
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1. Introduction

1.1 Safety Precautions

■ Use the board with expert technical supervision. There is high voltage (110 V, 240 V AC) power 
on the board.

■ Accidental human contact with high voltage is dangerous.
■ The capacitors on the board can be energized even after disconnecting the board from the main 

power supply. Be careful to not touch any parts on the board immediately after you disconnect the 
main power supply.

■ Safety plastic casing is provided on the top of HV section. Do not touch the protected area during 
live operation for debugging, probing, or any other purpose. 

Cypress bears no responsibility for any consequences that may result from the improper or 
hazardous use of this board.

This board is for evaluation only and should not be directly used in an end user application.

1.2 Introduction to the Cypress PLC Solution
Cypress’s Powerline Communication Solution (PLC) enables transmission of command and control
data over high voltage and low voltage powerlines. This solution is developed for low bandwidth
powerline communication. 

The CY3272 PLC High Voltage (HV) Evaluation Board demonstrates the ability of the Cypress
CY8CPLC10 to transmit data at 2400 bps over high voltage (110 V to 240 V AC) powerlines. 

This guide includes:
■ Chapter 1 provides a brief overview of the Cypress PLC solution. It describes the contents of the 

CY3272 evaluation kit and lists additional requirements to run the example projects, which are 
included as part of the kit. 

■ Chapter 2 gives a detailed hardware description of the PLC HV Board. It describes features of the 
HV board such as manual addressing, connection of the USB-I2C bridge, and jumper settings.

■ The Appendix contains the schematics, layout, and Bill of Materials.

CAUTION: High Voltage (Risk of Electric Shock)
All work in powerline communications must be done with extreme care. 
Caution must be exercised when using power supplies or power related equipment.
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1.3 Using the Cypress PLC Solution
Powerlines are available everywhere in the world, which makes them one of the most widely avail-
able communication media. The pervasiveness of powerlines also makes it difficult to predict its
characteristics and noise. Because of the variability of the quality of powerline, implementing robust
communication over powerline has been an engineering challenge for years. With this in mind, the
Cypress PLC solution is designed to enable secure, reliable, and robust communication over power-
line. Some of the features of Cypress PLC are:
■ Integrated powerline PHY modem with optimized filters and amplifiers to work with rugged high 

voltage powerlines.
■ Powerline optimized network protocol that supports bidirectional communication with acknowl-

edgement based signaling and multiple retransmit. 
■ Support for 8-bit packet CRC and 4-bit header CRC for error detection and data packet retrans-

mission. 
■ Carrier Sense Multiple Access (CSMA) scheme that minimizes collisions between packet trans-

missions on the powerline. 

The Cypress PLC solution contains three key elements as shown in Figure 1-1.
■ Powerline Network Protocol Layer
■ Physical Layer frequency shift keying (FSK) Modem
■ Power Amplification and Coupling Circuits

Figure 1-1.  Cypress PLC Solution Block Diagram
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The powerline network protocol layer and physical layer FSK modem are implemented on the
CY8CPLC10 chip. The power amplification and coupling circuits are built using discrete compo-
nents. The CY3272 board contains the CY8CPLC10 device along with the power amplification and
coupling circuit for communicating on high voltage (110 to 240 V AC) powerlines. For a detailed
description of the design parameters for the circuit, refer to the application note "Cypress Powerline
Communication Board Design Analysis - AN55427".

The CY8CPLC10 device is controlled by an external host microcontroller via an I2C interface. To
evaluate this kit, an external host must be created. 
■ The first option is to use a PC to install and run the Cypress PLC Control Panel GUI, which is 

included with this kit. The PC interfaces to the CY3272 board via the CY3240-I2USB Bridge  
board that is included with this kit. Steps for setting up this system are provided in the quick start 
guide, which is provided in the kit.

■ The second option is to use an external microcontroller that is running a host application. The 
application note, AN52478 - Designing an External Host Application for Cypress's Powerline 
Communication IC CY8CPLC10,  provides an example project that can be programmed on a 
PSoC microcontroller board (in this case, the CY3210-PSoCEVAL1) and explains how to inter-
face it to the CY3272 board. This application note is provided with this kit.

Note To evaluate this kit, a second high voltage PLC kit is required. The compatible kits are CY3272
(this kit) and CY3274 High Voltage PLC Development Kit. For information on these kits, visit
http://www.cypress.com/go/CY3272 and http://www.cypress.com/go/CY3274. For details on how to
program CY3274 boards with an I2C-PLC interface, refer the Appendix A.2 of the PLC Control Panel
GUI User Guide.

1.4 Kit Contents
The PLC HV evaluation kit consists of the following:
■ CY3272 Quick Start Guide
■ CY3272 PLC HV Evaluation Board
■  Five CY8CPLC10-PVXI Samples
■ CD containing:

❐ Packet Test Software – PLC Control Panel Application
❐ PLC Control Panel Release Notes
❐ CY3272 Release Notes
❐ CY8CPLC10 Datasheet
❐ CY3272 Evaluation Board User Guide
❐ CY3272 Board Altium Design Project
❐ CY3272 Board schematics, layout, and BOM
❐ Application Note – AN52478 - Designing an External Host Application for Cypress's Powerline 

Communication IC CY8CPLC10
■ AC Power Cable
■ USB-I2C Bridge
■ Ribbon Cable for I2C communication, External Reset, and Powering External Board
■ Retractable USB Cable
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1.5 Additional Learning Resources
Visit  http://www.cypress.com/go/plc for additional learning resources in the form of datasheets, tech-
nical reference manuals, and application notes. 
■ CY3272 Schematic.pdf

http://www.cypress.com/?rID=38024
■ CY3272 Board Layout.zip

http://www.cypress.com/?rID=38024
■ CY3272 Kit documentation

http://www.cypress.com/go/CY3272
■ For a list of PSoC Designer-related trainings, see

http://www.cypress.com/?rID=40543
■ CY8CPLC10 data sheet

http://www.cypress.com/?rID=38236
■ For more information regarding PSoC Designer functionality and releases, refer to the user guide 

and release notes on the PSoC Designer web page:
www.cypress.com/go/psocdesigner

■ For more information regarding PSoC Programmer, supported hardware, and COM layer, go to 
the PSoC Programmer web page:
www.cypress.com/go/psocprogrammer

■ Designing an External Host Application for Cypress's Powerline Communication IC CY8CPLC10 
- AN52478
http://www.cypress.com/?rID=37956

1.6 Additional Requirements
The following Cypress demonstration kit is used in the example applications in this user guide. This
kit is available for purchase from http://www.cypress.com/go/CY3210-PSoCEVAL1.
■ CY3210-PSoCEval1 Kit

This PSoC® evaluation kit features an evaluation board and MiniProg1 programming unit. The eval-
uation board includes an LCD module, potentiometer, LEDs, and plenty of bread boarding space to
meet all your evaluation needs. The MiniProg1 programming unit is also included with the kit and
programs PSoC devices directly on the evaluation board, or on other boards via a 5-pin header. This
programming unit is small and compact, and connects to a PC via a provided USB 2.0 cable.

The kit includes:
■ Evaluation Board with LCD Module 
■ MiniProg1 Programming Unit 
■ PSoC Designer™ Software CD 
■ 28-Pin CY8C29466-24PXI PDIP PSoC Device Sample 
■ USB 2.0 Cable
■ Getting Started Guide 
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1.7 Document Revision History 

1.8 Documentation Conventions 

Table 1-1.  Revision History

Revision
PDF 

Creation 
Date

Origin 
of 

Change
Description of Change

** 08/13/09 IUS New kit guide.
*A 12/10/09 RARP Content updates

*B 09/28/10 RKPM Added Software Installation, Example Projects, and Technical Refer-
ence sections. Added schematic in section 2.3. 

*C 02/11/2011 FRE
Added references to the compatible high voltage PLC kits. Added a ref-
erence to the quick start guide for evaluation. Added clarifications to the 
text throughout.

*D 09/28/2011 ADIY
Removed reference to CY3276 and CY8CLED16P01. Added Getting 
Started Section. Modified Figure 3-7. Updated Figure 1-1. Updated 
hyperlinks.

Table 1-2.  Document Conventions for Guides

Convention Usage

Courier New
Displays file locations, user entered text, and source code:
C:\ ...cd\icc\

Italics Displays file names and reference documentation:
Read about the sourcefile.hex file in the PSoC Designer User Guide.

[Bracketed, Bold] Displays keyboard commands in procedures:
[Enter] or [Ctrl] [C]

File > Open Represents menu paths:
File > Open > New Project

Bold Displays commands, menu paths, and icon names in procedures:
Click the File icon and then click Open.

Times New Roman Displays an equation:
2 + 2 = 4

Text in gray boxes Describes Cautions or unique functionality of the product.
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2. Getting Started

This chapter describes how to install and configure the CY3272 - HV PLC Evaluation Kit.

2.1 Kit Installation
To install the kit software, follow these steps:
1. Insert the kit CD in the CD drive of your PC. The CD is designed to auto-run and the Kit Installer 

Startup Screen appears.
2. Click Install CY3272 High Voltage PLC Kit to start the installation.

Figure 2-1.  Kit Installer Startup Screen
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Note If auto-run does not execute, double-click the cyautorun.exe file on the root directory of the CD.

Figure 2-2.  CD Root Directory

3. The CY3272 - HV PLC Evaluation - InstallShield Wizard screen appears. Choose the folder loca-
tion to install the setup files. You can change the location of the folder using Change.

4. Click Next to launch the kit installer.

Figure 2-3.  CY3272 - HV PLC Evaluation InstallShield Wizard
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5. On the Product Installation Overview screen, select the installation type that best suits your 
requirement. The drop-down menu has the options Typical, Complete, and Custom. 

6. Click Next to start the installation.

Figure 2-4.  Installation Type Options
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7. When the installation begins, a list of all packages appears on the Installation Page.
8. A green check mark appears next to every package that is downloaded and installed (see 

Figure 2-5).
9. Wait until all the packages are downloaded and installed successfully.

Figure 2-5.  Installation Page
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10.Click Finish to complete the installation.

Figure 2-6.  Installation Completion Page

2.2 Software Installation

2.2.1 Before You Begin
All Cypress software installations require administrator privileges; however, this is not required to run
the installed software.
■ Shut down any Cypress software that is currently running.
■ Disconnect any Cypress devices (USB-I2C bridge, ICE Cube, or MiniProg) from your computer.

2.2.2 Prerequisites
The PLC Control Panel requires the latest versions of Microsoft .NET Framework, Adobe Acrobat
Reader, and a Windows Installer. If your computer does not have .NET Framework and Windows
Installer, the installation automatically installs it. However, if your computer does not have Adobe
Acrobat Reader, download and install it from the Adobe website.

2.2.3 Installing PLC Control Panel Software
The PLC Control Panel GUI is installed as a prerequisite when you install the CY3272 PLC HV Eval-
uation kit. Follow the steps shown on the screen to complete the installation. If you need to reinstall
this application, select Install PLC Control Panel GUI from the installation screen (see Figure 2-1
on page 11).

Click Start > All Programs > Cypress > PLC Control Panel > PLC Control Panel.
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The PLC Control Panel application controls the CY3272 PLC HV Evaluation Kit over USB interface
from a PC. The application's startup display, when a board is attached and operating, is shown in
Figure 2-7.

Figure 2-7.  PLC Control Panel Application Startup Display

After installing the PLC Control Panel, refer to the documentation as needed: 
■ <CD Drive>\Software\PLC Control Panel\PLC Control Panel Release 

Notes.pdf

■ <CD Drive>\Software\PLC Control Panel\User Guide for Cypress PLC Con-
trol Panel GUI.pdf

The PLC Control Panel user guide is also available in the installation directory. It contains more infor-
mation about installation and how to set up the kit to work with the GUI. It can also be accessed from
the Help menu in the PLC Control Panel GUI.
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3. PLC HV Evaluation Board

3.1 Features
The key features of the CY3272 evaluation board are: 
■ User friendly PLC Control Panel Application available on the kit CD
■ Chip power supply derived from 110 V to 240 V AC
■ On-chip powerline network protocol layer and physical layer FSK modem
■ LED status indicators for Power, Powerline Transmit and Receive, and Band in Use.
■ Five-position DIP switches

❐ Three DIP switches for manual powerline node logical address selection
❐ One DIP switch to configure I2C slave address
❐ One DIP switch to select between external crystal and oscillator

■ On board surge protection and isolation circuit
■ Integrated Powerline Modem PHY

3.2 Functional Overview
The PLC evaluation board is designed as an advanced evaluation, testing, and product development
platform for low bandwidth (2400 bps) powerline communication. 

Data to be transmitted is sent to the CY8CPLC10 through the I2C serial communications interface
using a serial bridge driver to a PC or PSoC device. The serial bridge application on the
CY8CPLC10 receives this I2C data and encapsulates it into a PLC Network packet. The on-board
FSK modem modulates this packet and the coupling circuitry incorporates the resulting sinusoidal
waveform onto the existing waveform on the high voltage powerline bus.

3.2.1 Operating Conditions:
■ Input Voltage: 110 VAC/240 VAC
■ Input Current: 100 mA/50 mA
■ Operating Temperature: 0 °C to 40 °C 
■ Operating Humidity Condition: 5% to 95% relative humidity (RH), non-condensing
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3.3 Hardware Description
The high voltage PLC evaluation Board is shown in Figure 3-1. The key sections are highlighted.
The low voltage section (top half in Figure 3-1) is isolated from the high voltage section by the PLC
coupling transformer and the power supply's isolation transformer. The board is divided into four
main sections:
■ High voltage section with power supply
■ Transmit amplifier and filter section
■ Transmit and receive coupling circuit section
■ Cypress powerline transceiver and user controls

Figure 3-1.  Front View of Cypress PLC HV Evaluation Board

The communication signal flow on this HV board is: 

Transmit: CY8CPL10 TX pin → Transmitter Filter Circuitry  → Power Amplifier Circuitry  → High Volt-
age Powerline Coupling Circuitry  → High Voltage Powerline (110 V to 240 V AC)

Receive: High Voltage Powerline (110 V to 240 V AC) → High Voltage Powerline Coupling Circuitry
→ Passive Low Pass Filtering  → Vdd/2 Biasing  → CY8CPLC10 RX pin

The core of the PLC HV board is the CY8CPLC10 chip. The board contains an I2C connector, jump-
ers to control various functions, and a five-position DIP switch.
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The key components in all these sections are as follows.

3.3.1 High Voltage Section with Switched Mode Power Supply (SMPS)
This section takes the power from the powerline and generates necessary low DC voltage for the
operation of the PLC transceiver and other components on the chip.

The key components in this section are as follows:

Table 3-1.  SMPS Section

The key components are circled in the following schematic.

Figure 3-2.  Power Supply Schematic

Component Description

J7 This is the two pin connector where the AC cable hooks up to the powerline. 

F1 Protection fuse for the circuit.

D7 Full wave bridge rectifier IC. 

T3 Common mode choke. 

U6 IW1690-07 – iWatt high performance AC/DC power supply controller. 

T2 Flyback transformer.

U5 5-V  regulator.

[+] Feedback 

http://ccc01.opinionlab.com/o.asp?id=wRiLHxlo&prev=docurate_001-55381_pdf_p_19


20 CY3272 Cypress High Voltage Powerline Communication Evaluation Kit Guide, Doc. # 001-55381 Rev. *D

PLC HV Evaluation Board

3.3.2 Transmit Amplifier and Filtering Section
This section takes the output signal from the transceiver chip. The circuit here amplifies the signal
and filters it to make it suitable for transmission over the powerline. Filtering is done in three stages. 

The key components in this section are as follows:

Table 3-2.  Transmit Amplifier and Filtering

The key components are circled in the following schematic.

Figure 3-3.  Coupling Circuit Schematic

Component Description

U2, U3 
These opamps filter the signal from the CY8CPLC10, removing the harmonics. The filter 
stages are only required to meet the European CENELEC EN50065-1:2001 signaling speci-
fication. They are not required to achieve robust PLC communication

U4, Q1, Q2 This opamp and high gain transistors are used in the power amplification stage.
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3.3.3 Transmit and Receive Coupling Circuit 
This circuit couples the signal from the board on to the powerline. On the receive side, the same cir-
cuit couples the carrier on the powerline in to the board, while filtering out the actual 50 Hz or 60 Hz
power. The isolation transformer is required for safety. 

The key components in this section are as follows:

Table 3-3.  Transmit and Receive Coupling Circuit

The key components are circled in the following figure.

Figure 3-4.  Coupling Circuit

3.3.4 Cypress Powerline Communication Transceiver and User Controls
This section has the CY8CPLC10 chip, which has the integrated transmit and receive modem, and
network protocol layer. It also has the I2C header to communicate with the external host processor.
The DIP switches to control the addresses and the jumpers to control the functionality of the chip are
also located in this section of the board. The red, blue, yellow, and green LEDs indicate the status of
the board while functioning. 

The key components and their detailed use are as follows:

Table 3-4.  Transceiver and User Controls

Component Description/Comment

T1 This is the isolation transformer that isolates the HV and LV sections of the board. It has 
a 1:1 turns ratio.

C9 
This is the coupling capacitor which couples the communication signal and filters out the 
low frequency noise. The voltage and  X1/X2 safety ratings of this component are impor-
tant parameters. 

Component Description/Comment

CY8CPLC10 This is the Cypress powerline transceiver device. It is a 28 pin SSOP device. 

PWR LED[DS5] This is a blue LED that glows when the board is powered on. 

TX LED[DS3] This is a green LED that glows when the board is transmitting data on to the powerline.

RX LED[DS2] This is a red LED that glows when the CY8CPLC10 device is receiving data.

BIU LED[DS4] This is a yellow LED that glows when the transmit frequency band is in use. 

S1[3-5]

These dip switches set up the logical address of the node in the network. These 
switches provide an easy way to quickly assign an address from 0 to 7 to the board in a 
network. S1[3] is MSB and S1[5] is LSB for logical address assignment. If the address is 
modified, the board must be reset to reflect the changes.
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The key components are circled in the following schematic.

Figure 3-5.  Interface Section

S1[2]
This dip switch sets the I2C slave address to establish the communication with a host 
processor. Setting the switch to OFF or ON will set the I2C address to external 0x01 or 
0x7a respectively.

S1[1]
This dip switch controls the clock setting to the CY8CPLC10. Setting the switch to OFF 
or ON will set the FSK modem clock to external 32 kHz crystal or external 24 MHz oscil-
lator, respectively.  Note that the external crystal is always required for protocol timing.

S2 Reset switch to reset the CY8CPLC10 chip.

Component Description/Comment
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3.4 Setting Up the PLC HV Board
This section describes the components of the PLC HV Evaluation Board, the process of setting man-
ual addresses on the PLC HV Board and the connection of USB-I2C Bridge and I2C Cable to the
I2C header on the board. 

Figure 3-6.  DIP Switches for Manual Addressing on the PLC Evaluation Boards

3.4.1 Setting Up Manual Addressing on PLC Boards
The PLC Evaluation Board contains a five-position DIP switch (S1). The three switches S1[3-5] are
used to manually set a logical address for the PLC chip. Logical Addresses for up to 8 nodes can be
set up using these DIP switches. 

S1[3] is the MSB. S1[5] is the LSB. Set the dip-switch to the ON position for the particular bit to be
logic  '1' and the OFF position for it to be logic '0'. For example, for setting logical address of 0X06: 

S1[3] → ON = 1

S1[4] → ON = 1

S1[5] → OFF = 0

Note that the powerline network protocol supports 8-bit logical addressing, 16-bit extended logical
addressing, and 64-bit physical addressing; all of these are supported through software. An external
host microcontroller or a PSoC can talk to the CY8CPLC10 memory map to set the appropriate
mode and configure a particular logical address. 

Manual addressing is an easy method to quickly assign a particular address between 0 and 7 to the
board which may be a node in a network. 

Note After changing the address of the node, the RESET button on the board must be pressed on
the PLC HV Board for the change to take effect.

3.4.2 Setting Up I2C Address of the Node
I2C DIP switch S1[2] is used to assign a specific I2C address to the node for communicating with the
external microcontroller/PSoC or USB-I2C bridge. When the I2C switch S1[2] is in the OFF position,
the address of the node is 0x01 and when it is in the ON position, the address of the node is 0x7A.
For further details on I2C addressing, refer to the device data sheet, which is on the CD. 

3.4.3 I2C Header Settings
The I2C header, J5, is a five pin header that can be used for communicating with an external board,
powering an external board, and resetting the CY8CPLC10 device from an external board. A five
wire ribbon cable is provided with this kit for use on the J5 header. The description for J5 header pins
is as follows:
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Table 3-5.  J5 I2C Header Pins

Figure 3-7.  I2C Header for Communication

3.4.4 Jumper Settings for the PLC HV Board
Figure 3-8.  Jumpers Available On CY3272 Board

J5 Pin Name Description

V  –  Vdd

The Vdd pin can provide a maximum of 50 mA at 5 V to an external board. It is only 
to source the current. DO NOT SUPPLY POWER TO THIS PIN FOR POWERING 
THE CY8CPLC10 DEVICE. Note that the PWR jumper, as explained in the next 
section, needs to be connected to enable this functionality.

G  –  Gnd The Gnd pin can provide the ground reference to an external board. This pin con-
nects to the ground of the CY3272 board.

D  –  I2C Data (SDA)
The I2C Data (SDA) pin is the data line for the I2C communication. This pin is 
directly connected to the I2C_SDA pin on the CY8CPLC10 device. Check the next 
section for appropriate jumper settings for I2C communication through this pin. 

C  –  I2C Clock (SCL)
The I2C Clock (SCL) pin is the clock line for the I2C communication. This pin is 
directly connected to the I2C_SCL pin on the CY8CPLC10 device. Check the next 
section for appropriate jumper settings for I2C communication through this pin.

R  –  Reset
Connecting the reset of an external board to this pin enables the resetting of the 
CY8CPLC10 device via the external board. Note that RES jumper, as explained in 
the next section, needs to be connected to enable this functionality.
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Table 3-6.  Jumper Description

3.5 Example Project
The CY3272 kit is designed for systems that require a communication interface over commercial
high-voltage Powerlines. Typically, these systems consist of a microcontroller or processor along
with other electronic components that implement the host application functionality. For more informa-
tion on this interface, see AN52478 Designing an External Host Application for Cypress's Powerline
Communication IC CY8CPLC10.

3.6 Technical Reference
For a real-time list of knowledge base articles for the CY3272 kit, refer to our Online Knowledge
Base.

For any help with the installation of the Control Panel, refer to the Control Panel User Guide provided
in the kit CD. You can also download the latest revision of the GUI setup and user guide from
www.cypress.com/go/plc. 

Jumper Name Use

INT
This is not a jumper. It is a 2-pin header to connect the interrupt pin of the CY8CPLC10 
device to an external host. Refer to the CY3272 board schematics to determine interrupt 
and ground pins for this header.

PWR

This jumper should be connected if the user wants to provide power to an external board. 
Once this jumper has been connected, power for the external board can be derived from 
the V (Vdd) and G (Gnd) connectors on the I2C header (J5). For example, if we connect 
another PSoC EVAL1 board with this board, the PLC board can supply power to that 
board as well. The CY3272 board can provide a maximum of 50 mA at 5 V to an external 
board through the V and G pins on the I2C header (J5).

RES
This jumper is for enabling Reset of the PLC device through an external board. Once this 
jumper has been connected, the external board reset can be connected to the R (Reset) 
pin on the I2C header (J5).

SCL

This is a pull up jumper. While communicating through I2C (J5), one side has to pull up 
the line. When the jumper is connected, the SCL line will get pulled high. This needs to be 
done when the user wants the I2C link to be pulled up by the CY3272 board.
This jumper does not need to be placed if the USB-I2C bridge is used for communication 
to the host.

SDA

This is a pull up jumper. While communicating through I2C (J5), one side has to pull up 
the line. When the jumper is connected, the SDA line will get pulled high. This needs to be 
done when the user wants the I2C link to be pulled up by the CY3272 board.
This jumper does not need to be placed if the USB-I2C bridge is used for communication 
to the host.

CLK This jumper is not available for use and should be left unconnected by the user.
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A. Appendix

A.1 Schematics

A.1.1 Board Overview
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A.1.2 User Interface
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A.1.3 Transmit and Receive Filters
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A.1.4 Power Supply
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A.2 Layout

A.2.1 Top Layer 
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A.2.2 Ground Layer
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A.2.3 Power Layer
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A.2.4 Bottom Layer
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A.2.5 Top Silkscreen
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A.2.6 Bottom Silkscreen
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A.3 Bill of Materials

Description Designator Quantity Value Manufacturer Manufacturer 
Part# Digi-Key#

Capacitor Ceramic 0.10UF 
10% 16 V X7R 0603

C1, C5, 
C16, C17, 
C18, C24, 
C27, C34

8 0.1 µF Panasonic ECJ-1VB1C104K PCC1762CT-ND

Capacitor Ceramic 1.0nF 
X7R 10% 25 V C0603 C2 1 1.0nF Murata GRM033R71E10

2KA01D 490-3184-1-ND

Capacitor Ceramic 0.01 µF 
25 V X7R 0603

C3, C4, 
C10, C36 4 0.01 µF AVX 06033C103JAT2

A
06033C103JAT2
A-ND

Capacitor Ceramic 1.0 µF 
16 V X7R 0603

C6, C12, 
C13, C14, 
C15

5 1.0 µF Taiyo Yuden EMK107B7105K
A-T 587-1241-1-ND

Capacitor Ceramic 22pF 
100 V C0G 0603 C7, C8 2 22pF Murata GRM1885C2A22

0JA01D 490-1335-1-ND

Capacitor .15UF 300 VAC 
INTER SUPP X1 C9 1 0.15 µF Panasonic ECQ-U3A154MG P11117-ND

Capacitor Ceramic 10.0 µF 
10% 25 V X5R 1206

C19, C26, 
C33 3 10.0 µF Taiyo Yuden TMK316BJ106KL

-T 587-1337-1-ND

Capacitor Ceramic 1000PF 
1% 5 V NP0 0603

C20, C21, 
C22, C23 4 1.0nF, 

1% AVX 06033A102FAT2
A

06033A102FAT2
A-ND

Capacitor Ceramic 470PF 
250 VAC X1Y1 RAD C28 1 470pF TDK CD95-

B2GA471KYNS 445-2407-ND

Capacitor .022UF 300 VAC 
INTER SUPP X1 C29 1 0.022 

µF Panasonic ECQ-U3A223MG P11112-ND

Capacitor Electrolytic 4.7 µF, 
400 V C30, C31 2 4.7 µF, 

400 V Nichicon UVR2G4R7MPD 493-1229-ND

C30, C31 
(2nd 
Source, 
105C rated)

4.7 µF, 
400 V

United Chemi-
Con

EKMG401ELL4R
7MJ16S 565-1411-ND

Capacitor Electrolytic 330 µF 
16 V 20% C32 1 330 µF, 

16 V Nichicon UPW1C331MPD 493-1784-ND

Capacitor Electrolytic 10 µF 
50 V 20% C35 1 10 µF, 

50 V Nichicon UPW1H100MDD 493-1890-ND

Capacitor Ceramic 1500pF 
10% 50 V X7R 0603 C41 1 1500pF Yageo CC0603KRX7R9

BB152 311-1184-2-ND

Transorb Voltage Suppressor 
430 V 1250A ZNR D1 1 430 V Panasonic ERZ-V07D431 P7251-ND

Dual Schottky Diode D6 1 ST Micro BAT54SFILM 497-2522-1-ND
Full Wave Diode Bridge D7 1 Fairchild DF10S DF10SCT-ND
Schottky Diode 100 V 1A 
SMA D8, D9 2 Diodes Inc B1100-13-F B1100-FDICT-

ND
Transient Voltage Suppres-
sor 400W 12 V BIDIRECT 
SMA

D10 1 Micro Com-
mercial Co SMAJ12CA-TP SMAJ12CA-

TPMSCT-ND

LED Red Clear 0805 DS2 1 Lite-On LTST-C170KRKT 160-1415-1-ND
LED Green Clear 0805 DS3 1 Lite-On LTST-C170KGKT 160-1414-1-ND
LED Yellow Clear 0805 DS4 1 Lite-On LTST-C170KSKT 160-1416-1-ND

LED Blue Clear 0603 DS5 1 Rohm SML-
E12BC7TT86 511-1589-1-ND
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Fuse 2A Slow Blow 250 VAC F1 1 2.0A Bel Fuse RST 2 507-1179-ND

Header 2-Pin 0.1 Centers J1, J2, J3, 
J4, P1, P2 6 Sullins PEC02SAAN S1012E-02-ND

Header 5-Pin Locking 
0.1Centers J5 1 Amp/Tyco 640456-5 A19471-ND

AC Power Connector J7 1 Schurter 4300.0097
Inductor 1500 µH 0.2A 5% 
Radial L3 1 1.5mH Taiyo Yuden LHL08TB152J LHL08TB152J-

ND

Inductor 22 µH 20% 1210 L4 1 22 µH Taiyo Yuden CBC3225T220M
R 587-1626-1-ND

Inductor 1mH 10% 1007 L5 1 1mH Taiyo Yuden CB2518T102K 587-2195-1-ND

Mounting Holes

MTG1, 
MTG2, 
MTG3, 
MTG4

4

Transistor NPN HV 40 V 1A 
SOT-89 Q1 1 Zetex FCX491ATA FCX491ACT-ND

Transistor PNP HV 40 V 1A 
SOT-89 Q2 1 Zetex FCX591A FCX591ACT-ND

Transistor NPN SOT-23 Q3 1 Fairchild MMBT3904LT1 MMBT3904LT1I
NCT-ND

NPN Silicon Planar Medium 
Power High-Gain Transistor Q4 1 TSC TS13003HVCT

Q4 (2nd 
source) ST Micro STX616-AP 497-7625-1-ND

Resistor 1.00k 1% 1/10W 
0603

R1, R3, R4, 
R25 4 1.00k Yageo RC0603FR-

071KL
311-1.00KHRTR-
ND

Resistor 2.1k 1% 1/10W 
0603 R2 1 2.10k Yageo RC0603FR-

072K1L
311-2.10KHRTR-
ND

Resistor 402 1% 1/10W 0603 R5 1 402 Yageo RC0603FR-
07402RL

311-402HRTR-
ND

Resistor 7.50k 1% 1/10W 
0603 R6, R7, R22 3 7.50k Yageo RC0603FR-

077K5L
311-7.50KHRTR-
ND

Resistor 330 1% 1/10W 0603 R8 1 330 Yageo RC0603FR-
07330RL

311-330HRCT-
ND

Resistor 20.0k 1% 1/10W 
0603 R9, R11 2 20.0k Yageo RC0603FR-

0720KL
311-20.0KHRCT-
ND

Resistor 2.0k 1% 1/10W 
0603 R10 1 2.0k Yageo RC0603FR-

072KL
311-2.00KHRCT-
ND

Description Designator Quantity Value Manufacturer Manufacturer 
Part# Digi-Key#

Resistor 22.1 1% 1/10W 
0603 R14 1 22.1 Yageo RC0603FR-

0722R1L
311-22.1HRCT-
ND

Resistor 10.0k 1% 1/10W 
0603

R15, R17, 
R18, R28, 
R29, R30, 
R31, R33

8 10.0k Yageo RC0603FR-
0710KL

311-10.0KHRTR-
ND

Resistor 4.02k 1% 1/10W 
0603 R16 1 4.02k Yageo RC0603FR-

072K02L
311-4.02KHRTR-
ND

Resistor 37.4k 1% 1/10W 
0603 R19, R20 2 37.4k Yageo RC0603FR-

0737K4L
311-37.4KHRCT-
ND

Description Designator Quantity Value Manufacturer Manufacturer 
Part# Digi-Key#
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Resistor 3.83k 1% 1/10W 
0603 R21 1 3.83k Yageo RC0603FR-

073K83L
311-3.83KHRCT-
ND

Resistor 4.99 1% 1/10W 
0603 R23 1 4.99 Yageo RC0603FR-

074R99L
311-4.99HRCT-
ND

Resistor 36.5 1% 1/10W 
0603 R26 1 36.5 Yageo RC0603FR-

0736R5L
311-36.5HRCT-
ND

Resistor 41.2 1% 1/10W 
0603 R27 1 41.2 Yageo RC0603FR-

0741R2L
311-41.2HRCT-
ND

Resistor 750k 1% 1206 R32 1 750k, 
1% Yageo RC1206FR-

07750KL
311-750KFRCT-
ND

Resistor 820k 1% 1206 R34 1 820k, 
1% Yageo RC1206FR-

07820KL
311-820KFRCT-
ND

Resistor 3.9 Ohm 1% 0805 R35 1 3.9 Yageo RC0805FR-
073R9L

311-3.90CRCT-
ND

Resistor 68.0K OHM 1/8W 
1% 0805 SMD R36 1 68k, 

1% Yageo RC0805FR-
0768KL

311-68.0KCRTR-
ND

Resistor 1.00 OHM 1/10W 
1% 0603 SMD R37 1 1.0 Yageo RC0603FR-

071RL
311-1.00HRCT-
ND

Resistor 100k OHM 1/10W 
1% 0603 SMD R38 1 100k Yageo RC0603FR-

07100KL
311-100KHRTR-
ND

Resistor 12.0K OHM 1/10W 
1% 0603 SMD R39 1 12k, 

1% Yageo RC0603FR-
0712KL

311-12.0KHRCT-
ND

Resistor6.8k, 1% 0603 R40 1 6.8k, 
1% Yageo RC0603FR-

076K8L
311-6.80KHRTR-
ND

Resistor 10.0 OHM 5W 5% 
WIREWND R41 1 10, 5W Vishay AC05000001009

JAC00
PPC5W10.0CT-
ND

DIP Switch 5 Position DIP-5 S1 1 E-Switch KAJ05LAGT EG4429-ND
Pushbutton N.O. S2 1 E-Switch TL3301AF160QG EG2526CT-ND

Isolation Transformer T1 1 Precision 
Components 0505-0821G

Power Trasnsformer EE-16 T2 1 3.2mH Shenzen 
Goldenway

EE-16 (5+5) (rev-
A)

T2 (2nd 
Source) 1 Renco Elec-

tronics RLCY-1014

24mH Common Mode Choke T3 1 24mH Shenzen 
Goldenway

EE8.3(2+2)-hori, 
(rev-A)

T3 (2nd 
Source) 1 Renco Elec-

tronics RLCY-101

CY8CPLC10 Part U1 1 Cypress CY8CPLC10-
28PVXI

Op-Amp 190MHz U2, U3, U4 3
National 
Semiconduc-
tor

LMH6639MF/
NOPB

LMH6639MFCT-
ND

Voltage Regulator 5 Volt U5 1 ST Micro LD1117S50CTR 497-1243-1-ND
Off-Line Switcher U6 1 iWatt iW1690-07

Oscillator Y1 1 24.00 
MHz Crystek C3290-24.000 C3290-24.000-

ND
Y1 (2nd 
source) Citizen CSX750FCC24.0

00M-UT 300-7214-2-ND

Crystal 32.768kHz 12.5pF Y2 1 32.768
kHz ECS Inc. ECS-3X8X X1123-ND

Description Designator Quantity Value Manufacturer Manufacturer 
Part# Digi-Key#
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